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Overview

This document will show how to acquire and install, configure, and use Visual Studio 2022 Community Edition with its
C/C++ workload!. Currently, it will only discuss console application development.

Introduction

Back in 1993, Microsoft released Visual C++, an amazing development tool intended to replace several of its compiler
products:

e  Microsoft C/C++ 7.0 (MS/PC-DOS, their professional tool)
e  Microsoft Quick C 2.5 (MS/PC-DOS IDE, for power users)
e  Microsoft QuickC for Windows 1.0 (Windows, for power users)

It blended the ease of using a visual integrated development environment (IDE) with its professional back-end compiler.

Since then, Microsoft Visual C++ has become part of Microsoft Visual Studio, arguably the most successful commercial
IDE. The current edition of the product is the 2019 edition, with a new edition arriving in 2022.

Currently, Visual C/C++ supports the ISO C17 and C++ 20 standards, with the 1ISO C++ 23 standard being nearly
complete. The community edition is particularly appealing as it is free for the following purposes: individual developers,
Open-Source projects, academic research, and educational use.

Acquiring Visual Studio 2022 Community Edition
Let’s start at the Visual Studio Website found here.

Free Visual Studio

8 Microsoft | Visual Studio  Develoger Tools Downloads  Buy v Subscriptions +

Code faster.
Work smarter.

Create the future with Visual Studio 2022

Select the Community 2022 Edition from the drop-down list control.

1 Visual Studio workloads refer to the collection of tools that support development in a particular language or platform. Examples of
workloads are: Python development, Desktop development with C++, and Game development with Unity.
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https://visualstudio.microsoft.com/vs/

The site will automatically start a download of the installer VisualStudioSetup.exe. The installer isn’t the full
software package, but an install manager. Your security software may block the download (its an executable file), so you
may have to unblock or indicate that the file is safe to download.

We will have to run this program, select the components.
Run VisualStudioSetup.exe

Each user may have slightly different experiences during the installation. These are likely due to difference in operating
system version and previously installed software.

You’ll typically see:

Visual Studio Installer

Before you get started, we need to set up a few things so that you
can configure your installation.

To learn more about privacy, see the Microsoft Privacy Statement.

By continuing, you agree to the Microsoft Software License Terms.

Continue

Click Continue.

This will take you to the major installation options window:

Installing — Visual Studio Community 2022 — 17.4.3

Workloads  Individual components  Language packs  Installation locations

@ Need help choosing what to install? More info Installation details

~ Visual Studio core editor
Web & Cloud (4)

The Visual Studio core shell experience, including
syntax-aware code editing, source code control and
@ ASPNET and web development Azure development work item management.
Build web applications using ASP.NET Core, ASP.NET, Azure SDKs, tools, and projects for developing cloud apps
HTML/JavaScript, and Containers including Docker supp... and creating resources using .NET and .NET Framework....

P Python development @ Node.js development

Editing, debugging, interactive development and source Build scalable network applications using Node,js, an
control for Python asynchronous event-driven JavaScript runtime.

Desktop & Mobile (5)

“ .NET Multi-platform App Ul development NE' .NET desktop development
Build Android, i0S, Windows, and Mac apps from a single Build WPF, Windows Forms, and console applications
codebase using C# with .NET MAUI. using C#, Visual Basic, and F# with NET and .NET Frame...

Location

Remove out-of-support components
C:\Program Files\Microsoft Visual Studio\2022\Community Change..

By continuing, you agree to the license for the Visual Studio edition you selected. We also offer the ability to download other software with Visual Total space required 1.13 GB

Studio. This software is licensed separately, as set out in the 3rd Party Notices or in its accompanying license. By continuing, you also agree to those
licenses. Install while downloading ~ Install

There are many options here and you are free to choose as many as you would like. I’'m just going to focus initially on the
essentials for C/C++ console development. If you already have Visual Studio installed, then just verify that the following
options are included or added.
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Adding the C++ workflow

With the Workloads tab selected, scroll down until you see Desktop development with C++.

Select that workflow.

Installing — Visual Studio Community 2022 — 17.4.3

Workloads  Individual components  Language packs

@ Need help choosing what to install? More info

“ NET Multi-platform App Ul development

Build Android, i0S, Windows, and Mac apps from a single

codebase using C# with NET MAUL,

Desktop development with C++

Build modern C+ + apps for Windows using tools of your

choice, including MSVC, Clang, CMake, or MSBuild,

Installation locations

n‘_;:l NET desktop development

Build WPF, Windows Forms, and console applications

using C#, Visual Basic, and F# with NET and .NET Frame...

| Windows Platform devel
Create applications for the Universal Windows Platform
with C#, VB, or optionally C+ +

Mobile development with C++
Build cross-platform applications for 05, Android or
Windows using C++.

Gaming (2)

Location
C:A\Program Files\Microsoft Visual Studic\2022\Community Change...

By continuing, you agree ta the license for the Visual Studio edition you selected. We also affer the ability to download other software with Visual
Studio. This software is licensed separately, as set out in the 3rd Party Notices or in its ing license. By you also agree to those
licenses.

Additional Options

The panel on the right side contains the specific elements that you have selected. Let’s add a few more.

Scroll the right-side list and add:

M Windows 11 SDK (10.0.22621.0)
M Windows 10 SDK (10.0.20348.0)

Then click Install.

Installation details

~ Desktop development with C++

* Included

«  C++ core desktop features

~ Optional
MSVC v143 - VS 2022 C++ x64/xB6 build t...
C++ ATL for latest v143 build tools (x86 &..
Windows 11 SDK (10.0.22000.0)
Just-In-Time debugger
C++ profiling tools
C++ CMake tools for Windows
Test Adapter for Boost.Test
Test Adapter for Google Test
Live Share
IntelliCade
C++ AddressSanitizer
C++ MFC for latest w143 build tools (x86...
C++ Modules for v143 build tools (x64/x8...
Windows 11 SDK (10.0.22621.0)

Remove out-of-support components

Total space required 9.17 GB

Install while downloading = Install

Installing — Visual Studio Community 2022 — 17.4.3

Workloads  Individual components  Language packs

© Need help choosing what to install? More info

P Python development
Editing, debugging, interactive development and source
contral for Python.

Desktop & Mobile (5)

NET Multi-platform App Ul development
Build Android, i05, Windows, and Mac apps from a single
codebase using C# with NET MAUL.

Desktop development with C++

Build madem C++ apps for Windows using taels of your
choice, including MSVC, Clang, CMake, or MSBuild.

*+7]  Mobile development with C++

Location
C:\Program Files\Microsoft Visual Studio\2022\Community Change...

©

Installation locations

Node.js development
Build scalable network applications using Node s, an
asynchronous event-driven JavaScript runtime.

NET desktop development
Build WPF, Windows Forms, and console applic;
using C#, Visual Basic, and F# with .NET and .NET Fra

Universal Windows Platform development
Create applications for the Universal Windows Platform
with C#, VB, or optionally C++

By continuing, you agree to the license for the Visual Studio edition you selected. We also offer the ability to download other software with Visual
Studio. This software is licensed separately, as set out in the 3rd Party Notices or in its accompanying license. By continuing, you also agree to those

licenses.

Installation details

Windows 11 SDK {10.0.22000.0)
Just-In-Time debugger

C4++ profiling tools

C++ CMake tools for Windows

Test Adapter for Boost.Test

Test Adapter for Google Test

Live Share

IntelliCode

C++ AddressSanitizer

C+ MFC for latest v143 build tools (x86...

Windows 10 SDK {10.0.20348.0}
Windows 10 SDK (10.0.19041.0)

Windows 10 SDK {10.0.18362.0)

ut-of-support components
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The Visual Studio Installer will now download the C++ development workload while installing it.

Note that this configuration will require approximately 12 GB of space.

Why the Windows 10/11 SDKs?

The Windows SDK (Software Development Kit) for C++ provides headers, libraries, metadata, and tools for building
Windows applications utilizing the Universal Windows Platform (UWP) or Win32 (the core Windows API). Without
them, you would be restricted to 1SO console applications only. Windows 11 has more features than Windows 10, so we
install both.

Firstly, don’t worry about the version numbers. Just pick to most recent for each of Windows 11 and Windows 10 (the
highest version numbers presented).

The wait...

The installation time will depend on the speed of your CPU, amount of RAM, disk storage system, network, Internet
Service Provider, and how business the Microsoft Servers are today. Typically, this installation completes in 15 to 20
minutes?.

Visual Studio Installer

Installed  Available

Developer News
« Visual Studio Community 2022 Pause

Downloading and verifying: 1.57 GB of 2.94 GB (7 MB/sec)
52%

Write markdown without leaving Visual Studio

Markdown is a great solution when you want for...

December 21, 2022
Installing: package 322 of 434
33% Adding new files just got a lot faster
h  ———

Microsoft.\VC.14.24.17 4.CRT Headers base Have you ever felt like the New Item Dialog slows...

December 20, 2022
Start after installation

Sticky Scroll now in preview
Release notes When working in code with long classes and met...

December 15, 2022

View more Microsoft developer news...

Need help? Check out the Microsoft Developer
Community or reach us via Visual Studio
Support.

-

Installer version 3.4.2246.31370

Visual Studio will automatically start if you left the ‘Start after installation” option checked. If not, manually start Visual
Studio 2022.

2 This could take hours if you selected everything!

GATS Page 4 -9 G. Santor



Visual Studio 2022

Open recent Get started

s you use Visusl Studio, any projects, folders, or files that you apen will show up here for quick access. 4 Clone a repository

You can pin anything that you open frequently sa that it's always at the top of the st

ﬁ,ﬁ Open a project or solution

Open a local Visual Studio project or sin file

Open a local folder

Mavigate and edit code within any folder

@ Create a new project

You can now close the Visual Studio Installer.

Testing your installation

If Visual Studio is not running, launch it.

repository like GitHu

nplate with code seaffolding

From the ‘Get started’ window, choose ‘Create a new project’.

Choose ‘Console App’, then click ‘Next’.

-~
- m} X
Create a new pI’OJeCt Search for templates (Alt+5S) PH
Recent project temp|ates All languages < All platforms - All project types <
g_lisr of zohur recently accessed templates will be tfs Empty Project
EAREsl s Start from scratch with C++ for Windows. Provides no starting files.
C++ Windows Console
Console App
Run code in a Windows terminal. Prints “Hello World” by default.
Ct+ Windows Console
f'o_m CMake Project
Build modern, cross-platform C++ apps that don't depend on .sIn or .vexproj files.
C++ Windows Linux Consale
fros Windows Desktop Wizard
Create your own Windows app using a wizard.
C++ Windows Desktop Console Library
t;ﬂ Windows Desktop Application
A project for an application with a graphical y<gr interface that runs on Windows.
C++ Windows Desktop
&E TypeScript Console Application
Back | | Next
|- )
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You’ll now see the project configuration window.
You can change the name of the project to HellowWorld, and the location to something more suitable if you wish.

Click Create.

Configure your new project

Console App @+« wirdows  Comsole

Project name

Helloworld

Lacation

[ e — 1]

Salution name @

| [ Hetowerid

[] Piace solution and project i the same directory

L Back o= |

The IDE will now load with your project and present the automatically generated test program for C++ (its Hello, World).

” File Edit View Git Project Build Debug Test Analyze Tools Extensions Window Help | Search (Ctrl+Q) P | HelloWorld e — [m] X
- | Fiisig =4 | - d '| |Debug '| |x64 '| P Local Windows Debugger ~ > - | B3 | I A O | 9= | R AN : |/ Live Share &
Solution Explorer HelloWorld.cpp & X - &
o ﬂ% | s ® | @ ’ [ HelloWorld - (Global Scope) < ME]
1 =// HelloWorld.cpp : This file contains the 'main' function. Program execution begins and ends ther<=

Search Solution Explorer (Ctrl+;)

1/

2
£ Solution "HelloWorld' (1 of 1 project) 3
4 HelloWorld 4
b o0 References 5
6
7
8

#include <iostream>

sint main()

b &1 External Dependencies

I Header Files {
E¥ Resource Files std::cout << "Hello World!\n";
EF Source Files £ }

11 =// Run program: Ctrl + F5 or Debug > Start Without Debugging menu
12 |// Debug program: F5 or Debug > Start Debugging menu

14 =// Tips for Getting Started:
15 |// 1. Use the Solution Explorer window to add/manage files

16 |// 2. Use the Team Explorer window to connect to source control

17 |// 3. Use the Output window to see build output and other messages

18 |// 4. Use the Error List window to view errors

19 |// 5. Go to Project > Add New Item to create new code files, or Project > Add Existing Item to a¢

20 |// 6. In the future, to open this project again, go to File > Open > Project and select the .sln

21

v

SRRt Property Manager ~ Git Changes 56%  ~|®  ® Noissues found q b Ln:10 Ch:1  SPC  CRLF
D Ready I Add to Source Control « T Select Repository « [

Building and running the project is as simple as clicking either run button (P or [>).

If all is successful, you should see:
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Microsoft Visual Studio Debui X + -

Hello World!

C:\Users\gsantor\source\repos\HelloWorld\x6u4\Debug\HelloWorld.exe (process 19752) exited with code 0.
Press any key to close this window . . .

Command-line compiling.
Microsoft Visual Studio provides command-line access to its tool chain via a set of batch files. There are several batch
files, each configuring the environment for a different target space.

Examples:
File Environment
vcvars32.bat 32-bit Intel-compatible
vcvars64.bat 64-bit Intel-compatible
vcvarsall.bat All environments
vcvarsamdé4.bat 64-bit AMD-compatible
vcvarsamdéd_arm.bat AMD to ARM cross-compile environment
vcvarsamd64_armé4.bat AMD to ARM64 cross-compile environment
vcvarsamdé4_x86.bat AMD to Intel 32-bit cross-compile environment
vcvarsx86_amd64.bat 32-bit Intel-compatible to AMD64 cross-compile environment
vcvarsx86_amd.bat 32-bit Intel-compatible to ARM cross-compile environment
vcvarsx86_armé64.bat 32-bit Intel-compatible to ARM®64 cross-compile environment

I’ve found it easiest to add a path to the directory containing the batch files. The programmer selects the build
environment, then operates from the command line.

Setting the environment
Adding to the PATH

We’ll use control panel to modify the path.

1. Locate the folder containing the file vcvars64.bat. They are typically found in the folder C: \Program Files\Microsoft
Visual Studio\2022\Community\VC\Auxiliary\Build.

1.1. Copy the path
2. Launch the Systems Settings app:
2.1. Right click the start button

am Qs

2.2. Select: System
3. Click: Advanced System Settings
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3.1. The System Properties dialog will be presented

Click: Environment Variables..

From the “System Variables” box, select: Path

Click: Edit..

Click: New

Enter: C:\Program Files\Microsoft Visual Studio\2022\Community\VC\Auxiliary\Build
Click: OK

10. Click: OK

Testing the Environment

1. Launch the CLI shell (command-line interface operating system shell): cmd . exe
1.1. Type: #+R

1.2. Type: cmd+

© © N o g &

2. Type: vcvarsesd+

B CAWINDOWS\syst:
Version 10.0.19041.804

Create a C++ source file

Create a text file containing:

#include <iostream>

int main() {
std::cout << "Hello, world!\n";
}

Running the compiler
1. Launch the CLI shell in a folder with your .cpp files.

2. Type: vcvars64+
3. Type:cl /std:c++latest *.cpp+

% You may have a slightly different path if you installed Visual Studio in a different location.
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4. Verify the output files.

References
Microsoft Visual C++ on Wikipedia

Type: dir+

Microsoft Visual Studio on Wikipedia

Document History
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